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Overview
Audition for Windows 95/NT is a small utility that will allow you to play sound files located in a disk directory. A play list is created 
of all sound files found in the selected folder.

Audition for Windows 95/NT is fully Y2K compliant and will work with MS Windows 98 as well as Windows 95/NT systems.

Playing Sound Files
Sound files can be played individually, or the entire play list can be played one after another. Double-click your mouse on a 
sound file listed in the play list to hear individual sounds.

Context Menu
Right-click your mouse on a sound file in the play list to display a small popup menu containing the most commonly used 
Audition menu commands.

Editing Sound Files
Commands are included to launch your favorite WAV file editor and speaker volume control applications. These can be specified
using the Audition Options property sheet.

Purchasing Audition
Audition for Windows 95/NT is a fully functioning program. It is not crippled in any way.

Audition for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are 
required to register it. If after evaluating Audition for 30 days you decide not to register it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

You may also purchase Audition for Windows 95/NT using your credit card via the Internet or by telephone.

Audition for Windows 95/NT provides a simple means of playing and editing all of those sound files you’ve been collecting.



Installing Audition
Installation
To install Audition for Windows 95/NT on your computer simply create a new, empty folder and place the files; AUDITION.EXE, 
AUDITION.HLP and AUDITION.CNT there.

AUDITION.EXE - The Audition Application
AUDITION.HLP - The Windows 95 Help File
AUDITION.CNT - The Windows 95 Help Contents File

If you run the SETUP.EXE file that ships with Audition for Windows 95/NT and specify the default installation directory the files 
mentioned above will be placed in the C:\Program Files\Software by Design folder.

To integrate Audition for Windows 95/NT with the MS Windows Explorer select the Audition Explorer Setup property sheet while 
Audition is running.

Note If you have an earlier version of Audition for Windows 95/NT installed on your computer, simply replace the 
AUDITION.EXE and AUDITION.HLP files with the newer versions. Audition stores configuration information in the MS Windows 
95/NT System Registry.

Note The AUDITION.INI file is no longer used and can be deleted. The various application settings specified in the Audition 
Options property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT
System Registry.

Warning If you rename the AUDITION.EXE file you must also rename the HLP file using the same basename. For example if 
you change the Audition application file name to NewName.exe, rename the help file to NewName.hlp. The HLP and CNT files 
must reside in the same folder as the application file itself.



Configuring Audition
Audition Options
Select the File | Options menu item to display the Audition Options property sheet. This window will allow you change various 
Audition program settings.

Show Tool Ribbon Tips
Check this item to display small popup tip windows when the mouse pointer is moved over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Use New Windows 95/98 Toolbar Style
Check this item to display the toolbar ribbon using the newer “flat style” buttons.

Place Icon in Taskbar Tray
Check this item to display a small Audition icon in the Taskbar Icon Notification Tray. If this item is selected and the Audition 
window is minimized a button will not be added to the Taskbar, to restore the Audition window on the desktop press the small 
icon in the taskbar tray instead. This item is available to keep the taskbar free for other running windows.

Note When this option is selected, clicking on the Close box in the upper right-hand corner of the window title bar will 
minimize Audition instead of closing the application. To quit Audition right-click with your mouse on the Audition icon in the 
Taskbar tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Confirm Program Exit
Check this item to confirm quitting Audition for Windows 95/NT. When this option is selected you will be prompted to confirm 
your intention to exit Audition and return to the MS Explorer desktop. This item is useful if you run Audition from the tray and 
wish to avoid accidental exits when you right-click on the Audition tray icon.

Ask Before Deleting Play List Deletions
Check this box to confirm play list deletions. If this item is checked you will be prompted before removing sound files from the 
play list. Deleting a sound file from the play list does not delete the file on disk, but rather just removes it from the play list.

Reload Play List from Last Folder Used
Check this box to reopen the last folder that was used, and load the sound files into the play list whenever Audition is 
launched.

Dark Play List Window Background
Check this item to display the WAV file names in the play list window with a dark background instead of the paper white 
background MS Windows normally uses to display text.

Play Sounds Asynchronously
Check this box to play sound files asynchronously. Checking this item will allow sound files to be played in the background. 
This mode is automatically overridden while the Play All command is in effect.

Sounds with Warning Dialog Boxes
Check this box to play a short beep sound when Audition displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of Audition program options. When you press this button the 
Audition Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Audition Options property sheet without making any changes. If you have made any changes to 
the option settings, and then press this button your changes will not be used, and the previous settings will remain in use.

Help
Press this button to open the Audition Help Window and go directly to the Configuring Audition topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Audition Options 
property sheet itself will also be saved. Your settings will be saved in the MS Windows 95/NT System Registry.



Configuring Tools
Audition Options
Select the File | Options menu item and pick the Tools tab to display the Audition Tools property sheet. This window will allow 
you change various Audition tool settings.

Pause Between WAV Files
Specify the number of seconds to pause between WAV files when playing all files displayed in the play list. You can specify a 
time delay of between 0 and 15 seconds, where 0 prevents a delay between files being played.

Sound Editing Application
Specify the name of the sound editing program you would like to use for editing WAV files. Enter the full path and file name of 
the application you wish to use, or press the browse [...] button to the right of this entry field to select a file using the standard 
MS Explorer file browser.

Volume Control Application
Specify the name of the volume control program you would like to use when playing WAV files. Enter the full path and file 
name of the application you wish to use, or press the browse [...] button to the right of this entry field to select a file using the 
standard MS Explorer file browser.

OK
Press this button when you have completed your selection of Audition program options. When you press this button the 
Audition Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Audition Options property sheet without making any changes. If you have made any changes to 
the option settings, and then press this button your changes will not be used, and the previous settings will remain in use.

Help
Press this button to open the Audition Help Window and go directly to the Configuring Tools topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Audition Options 
property sheet itself will also be saved. Your settings will be saved in the MS Windows 95/NT System Registry.



Audition Explorer Setup
Audition Explorer Setup
Select the File | Options menu item to open the Audition Options property sheet. Select the Explorer tab to display MS 
Windows 95/NT Explorer setup options. This window will allow you to integrate Audition for Windows 95/NT with the Microsoft 
Windows 95/NT Explorer. You can also select the Help | Setup menu item to go directly to this window. Use this command to 
create and remove MS Explorer shortcuts for Audition for Windows 95/NT.

Create a Start Menu Item
Check this item to create a Audition Start Menu entry. The Audition for Windows 95/NT program will be located in the Software
by Design folder on the Programs menu. This item will be disabled (grayed) if a Audition item already exists in the Software by
Design folder.

Remove this Start Menu Item
Check this item to remove the Audition entry located in the Software by Design folder on the Programs menu. This item will be
disabled (grayed) if a Audition item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a Audition for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a Audition desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the Audition for Windows 95/NT program icon from the Explorer desktop. This item will be disabled 
(grayed) if a Audition desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run Audition for Windows 95/NT whenever Microsoft Windows is started. This option creates 
a Audition program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a Audition startup 
item already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove Audition from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a 
Audition startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the Audition 
Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the Audition Explorer Setup property sheet without creating or removing any MS Explorer shortcuts.

Help
Press this button to open the Audition Help window and go directly to the Audition Explorer Setup topic.



Recent Files Configuration
Recent File Configuration
Select the Recent | Settings menu item to open the Recent Files Configuration dialog box. Use this window to select the 
various Recent Files settings described below.

The first section of this dialog box allows you to specify folder names to be ignored when adding folder names to the Recent 
Files menu.

Ending with the ‘BAK’ File Extension
Check this item to ignore folders ending with the .BAK file extension.

Starting with the Prefix ‘Backup of’
Check this item to ignore folders starting with the prefix Backup of.

The second section of this dialog box allows you to remove all folder names from the Recent Files menu.

Clear the Recent Files Menu
Check this item to clear the Recent Files menu. Checking this item will delete the 9 most recently selected Audition folders.

OK
Press this button when you have completed your selection of Recent File settings. When you press this button the Recent 
Files Configuration dialog box will be closed and your settings will be saved.

Cancel
Press this button to close the Recent Files Configuration dialog box without making any changes. If you have made any 
changes to the Recent File settings, and then press this button your changes will not be used, and your previous settings will 
remain in use.

Help
Press this button to open the Audition Help window and go directly to the Recent Files Configuration topic.



Selecting Sound Files
Selecting Sound Files
Select the File | Open menu item to display the Sound Folder Browser. Use this dialog box to select a folder containing the 
sound files you would like to audition. Click your mouse on the folders listed in the left hand window to display a list of sound files
suitable for loading and playing.

Sound File Formats
Audition for Windows 95/NT will play WAV files, the most common form of sound files found on MS Windows 95/NT systems. 
WAV files are used by most programs and games that play sounds using your computer system’s multimedia equipment.

Note The desktop location of the Sound Folder Browser will be saved and used the next time you open it.



File Menu
File Menu Commands
The File menu provides commands used to work with the sound files used by Audition. A short description of each item follows:

Open
Opens the Sound Folder Browser window and allows you to select a folder containing sounds files. The Ctrl+O shortcut 
can also be used for this command.

Properties
Displays a small window showing file properties for the currently selected sound file. This window will display the sound 
file’s name, folder location, size, last modification date and file access permissions. The Alt+Enter shortcut can also be 
used for this command.

Options
Opens the Audition Options property sheet and allows you to change Audition program settings.

Exit
Closes the Audition program and returns control to the Explorer desktop. The Ctrl+Q shortcut can also be used for this 
command.

Tip Commonly used File menu commands can also be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of Audition play lists. A short description of each item follows:

Delete
Deletes the currently selected sound file from the play list, this command does not delete the sound file from the disk, but 
rather just removes it from the play list. The Del shortcut can also be used for this command.

Edit
Opens the sound editor program and loads the currently selected sound file from the play list for editing. The Ctrl+E 
shortcut can also be used for this command.

Tip Commonly used Edit menu commands can also be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change Audition display options. These items provide a means of changing the 
Audition window appearance. A short description of each item follows:

Toolbar
Use this command to turn the toolbar ribbon on and off. If this item is checked the Audition toolbar ribbon will be displayed 
below the menu bar. To hide the toolbar ribbon uncheck this item. Most commonly used Audition menu commands have a 
toolbar button. If the toolbar ribbon is turned off you will have to use the normal Audition menus.

Status
Use this command to turn the status region on and off. If this item is checked the Audition status region will be displayed at 
the bottom of the Audition window. To hide the status region uncheck this item. The status region displays current program 
status and will also display a brief description of each menu command as the mouse is moved.

Customize
Use this command to customize the Audition for Windows 95/NT toolbar ribbon. The standard MS Windows Toolbar 
Customization dialog box will be opened and displayed when this command is selected.

Font
Use this command to select the font style and size to be used when displaying sound file names in the play list.

Refresh
Refreshes the Audition play list to reflect the sound files currently located in the selected folder. The F5 shortcut can also be
used for this command. This command is useful if you’ve used the MS Explorer to move or delete sound files from the 
currently selected sound folder that Audition is using.

Minimize
Minimizes the Audition window to a button or icon on the taskbar. The Ctrl+Y shortcut can also be used for this command. 
To restore the window to the desktop press the Audition button on the taskbar, or the program icon in the taskbar 
notification tray.

Always on Top
Use this command to keep the Audition window top most on the desktop. When this item is checked the Audition window 
will float above all other non-topmost windows on the desktop. This item is useful if you normally run Audition with a small 
window that would be easily obscured by other applications. The Ctrl+T shortcut can also be used for this command.

Tip Commonly used View menu commands can also be invoked using shortcut keys or buttons on the toolbar ribbon.



Sound Menu
Sound Menu Commands
The Sound menu provides commands used to play the sound files listed in Audition’s play list. A short description of each item 
follows:

Play
Plays the currently selected sound in the play list. The Ctrl+P shortcut can also be used for this command. Double-clicking 
the mouse on a sound in the play list or pressing the Enter key will play individual sound files as well.

Play All
Use this item to play all of the sounds currently in the play list. The Ctrl+A shortcut can also be used for this command.

Stop
Stops playing the sounds in the play list when the Play All command was previously issued. The Esc shortcut can also be 
used for this command.

Volume
Opens the volume control program and allows you to change your system’s speaker volume level. The volume control 
program used will be the application you specified in the Audition Options property sheet.

Tip Commonly used Help menu commands can also be invoked using shortcut keys or buttons on the toolbar ribbon.



Recent Files Menu
Recent    Files Menu Commands
The Recent Files menu contains a list of the last 9 sound folders selected.

Select a folder name from this menu to quickly re-open a Audition folder you worked with recently.

Select the Recent | Settings menu item to configure the Recent Files menu.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help for Audition operations. A short description of each item follows:

Contents
Opens the Audition Help window and displays the Table of Contents. The F1 shortcut can also be used for this command.

Search
Opens Audition Help and displays the Search window. You can use this window to search for specific Audition help topics.

How to Use Help
Opens a Help window that explains how to use MS Windows 95 Help files.

Register
Displays the Audition Shareware Registration Wizard. This wizard allows you to register    Audition for Windows 95/NT for 
authorized use.

Setup
Displays the Audition Explorer Setup property sheet. This window provides options to integrate Audition with the MS 
Windows Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software Design web site on the Internet.

Send E-Mail to Author
Opens your Internet eMail client application and allows you to send an eMail message directly to the author at 
Gregory_Braun@CompuServe.com.

Note You must have your Internet eMail client software configured as your default Simple MAPI client for this command to 
work properly

About Audition
Displays the Audition splash box. This window contains the current version number of Audition and a program copyright 
notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help menu commands can also be invoked using shortcut keys or buttons on the toolbar ribbon.



Customizing the Toolbar
Customizing the Toolbar Ribbon
The Audition toolbar ribbon can be customized by selecting the View | Customize menu item. The standard MS Windows 95/NT
Toolbar Customization dialog box will be opened when this command is invoked. Use this window to add and remove Audition 
toolbar buttons as well as to change the order that the buttons appear on the toolbar ribbon.

Tip you can also move and delete toolbar buttons without opening the Toolbar Customization dialog box by simply shift-clicking 
with your mouse and dragging the button to a new location on the Audition toolbar ribbon itself. To delete buttons shift-click and 
drag the button off of the Audition toolbar ribbon.

Note Some versions of MS Windows 95 redraw the toolbar ribbon height incorrectly after customization, if this happens exit 
Audition and restart it again to restore the proper toolbar ribbon height.

Available Buttons
This list will contain the buttons available for adding to the Audition toolbar ribbon. Only buttons not currently installed on the 
toolbar ribbon will be displayed in this list.

Toolbar Buttons
This list will contain the buttons currently installed on the Audition toolbar ribbon.

Add
Press the Add button after selecting a toolbar button from the Available list. The tool button you have selected will be added to
the Audition toolbar ribbon at the current selection point.

Remove
Press the Remove button after selecting a toolbar button from the Toolbar list. The tool button you have selected will be 
removed from the Audition toolbar ribbon.

Close
Press the Close button to finish toolbar customization. The selection of toolbar buttons that you chose to include will be saved
and reloaded whenever Audition for Windows 95/NT is started.

Reset
Press the Reset button to restore the Audition toolbar ribbon to its original default settings.

Help
Press the Help button to open the Audition Help file and go directly to the Customizing the Toolbar topic.

Move Up
Use this button to move the currently selected button up one place in the toolbar button list. The currently selected button will 
appear one place to the left on the actual Audition toolbar ribbon when this command is used.

Move Down
Use this button to move the currently selected button down one place in the toolbar button list. The currently selected button 
will appear one place to the right on the actual Audition toolbar ribbon when this command is used.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used Audition menu commands can also be quickly invoked by pressing a button on the toolbar ribbon 
displayed at the top of the main window. These buttons work exactly the same way as the corresponding menu items that they 
duplicate.

The number of buttons and their order on the Audition toolbar ribbon may differ from the following description if you have 
customized the toolbar ribbon.

Open - Open the Sound Folder Browser

Refresh - Refresh the play list

Properties - Show document properties

Delete - Delete the current selection

Edit - Edit the current selection

Volume - Open the Speaker Volume program

Play  - Play the current selection

Play All - Play all files in the list

Stop - Stop playing sound files

Top - Make the window topmost

Font – Change window font style and size

Options - Open the Audition Options property sheet

Help - Open this Help file

About - Show Audition splash box

Tip If the Show Tool Ribbon Tips option was selected a small popup tip window will appear when the mouse pointer is placed 
over a button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke a menu item command without displaying the menu and then selecting an item. The 
most commonly used menu commands can be invoked using the following shortcut keys.

File Menu
Ctrl+O Open the Sound Folder Browser
Alt+Enter Show properties for the selected sound file
Ctrl+Q Exit Audition , and return to the desktop

Edit Menu
Ctrl+E Edit the selected sound file
Del Delete the selection

View Menu
F5 Refresh the play list
Ctrl+Y Minimize Audition to an icon
Ctrl+T Make window topmost

Sound Menu
Ctrl+P Play the current selection
Enter Play the current selection
Ctrl+A Play All files in the play list
Esc Stop playing sound files

Help Menu
F1 Display this Help file



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in Audition for Windows 95/NT please feel free to contact me via email or on 
CompuServe.

Gregory Braun – Software Design

CompuServe: 71613,2175
Email: Gregory_Braun@CompuServe.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



Release History
Audition for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added MS Windows 95/NT Help file. 

v2.3 Fixed several minor bugs. 

v2.4 Replaced INI file with MS Windows 95/NT System Registry entries.

v2.5 Increased the width of the wave file list in the Folder Selection dialog box. Added MS Windows 95/NT Explorer Setup 
facilities. Add help buttons to the various Audition dialog boxes.

v2.6 Added facilities to customize the toolbar ribbon. Converted the Audition Options dialog box to a three-tab property sheet. 
Fixed a bug that prevented proper window repositioning when the MS Explorer Taskbar was placed along the left edge or
at the top of the desktop and the Auto Hide option was active.

v2.7 Added a Recent Folders item to the File Menu.

v2.8 Added the Shareware Registration Wizard. Fixed several minor bugs. 

v2.9 Added support for MS Windows 98. Converted the sound file play list window to the new Win32 ListView control. Fixed 
several minor bugs. 

v3.0 Added an option    to introduce a short delay between files when the Play All command is invoked. Added the stand-
alone WAV Player applet. Fixed several minor bugs. 

v3.1 Added the Recent File Menu. Fixed several minor bugs. 

v3.2 Added a popup context menu to the play list. Fixed several minor bugs. 

v3.3 Fixes several minor bugs. 

v3.4 Added WAV sample information to the main play list. Fixed several minor bugs. 

Last Update  December 20th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



System Registry
Audition for Windows 95/NT System Registry Key
Audition for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are 
updated automatically while Audition is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Audition automatically updates registry entries when it exits. 
If you wish to edit these settings make sure Audition is not running while you edit them. If Audition is currently running your 
changes will be overwritten when Audition exits.

Audition for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
Audition for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. Audition will automatically maintain these settings for you. If you do 
edit these, you do so at your own risk.



Removing Audition
Removing Audition for Windows 95/NT
If you find that Audition for Windows 95/NT does not meet your needs you can remove it from your computer system by simply 
deleting the following files from your hard drive. All of these files will be located in the folder that you originally installed Audition 
in.

AUDITION.EXE Audition Application Program.
AUDITION.CNT Audition Help Topics File
AUDITION.HLP Audition Help File

If you ran the SETUP.EXE file that ships with Audition for Windows 95/NT and specified the default installation directory the files 
mentioned above will be found in the C:\Program Files\Software by Design folder.

If you have opened and used the Audition for Windows 95/NT Help files your system may contain the following two (2) files. 
These files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely 
removed.

AUDITION.GID MS Windows Help settings file. This file contains the Audition Help window size and desktop location as 
well as any bookmarks you may have created.

AUDITION.FTS MS Windows Help word database. This file is created when you build a custom word list for Audition Help 
files. This file is used to search for words and phrases in the Audition Help files.

Audition for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above from 
your system’s hard drive you will have completely removed Audition from your computer system.

Note If you have installed Audition shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the Audition files mentioned above.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software programs there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site and can also be found on CompuServe, ExecPC, MSN and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
Go Postal for Windows 95/NT (GOPOSTAL.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
Audition for Windows 95/NT (AUDITION.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Submit It for Windows 95/NT (SUBMITIT.ZIP)
File Shredder for Windows 95/NT (SHREDDER.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"Audition for Windows 95/NT v3.4"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering Audition for Windows 95/NT
Registering Audition
Audition for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are 
required to register it. If after evaluating Audition for 30 days you decide not to register it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Audition for Windows 95/NT by mailing the Order Form provided with this software. When you register Audition 
for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be
mailed to you.

You may also purchase Audition for Windows 95/NT using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when Audition for Windows 95/NT is first launched.

To register your copy of Audition for Windows 95/NT select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered Audition for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered Audition for Windows 95/NT. If you did not 
specify an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased Audition for Windows 95/NT. Refer to the notification 
letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered Audition for Windows 95/NT. When you successfully register your 
copy of Audition this box will automatically be unchecked for you. If you wish to see the splash box when Audition is launched 
return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete Audition for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the Audition Help window and go directly to the Registering Audition topic.



Purchasing Information
Purchasing Information
Audition for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are 
required to register it. If after evaluating Audition for 30 days you decide not to purchase it you are required to remove it from 
your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Audition for Windows 95/NT by mailing the Order Form provided with this software. When you register Audition 
for Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be
mailed to you.

You may also purchase Audition for Windows 95/NT using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when Audition for Windows 95/NT is first launched.

Single User Licensing
Individual users can register Audition for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to you 
please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of Audition directly from the Software Design web site on the Internet. Print the Audition for 
Windows 95/NT Order Form and mail it with your check to become a registered user of Audition for Windows 95/NT.

Site Licensing
Audition for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and 
use Audition on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk 
and entitles you to unlimited free updates and telephone support. You can always download the latest release of Audition directly
from the Software Design web site on the Internet. Print the Audition for Windows 95/NT Order Form and mail it with your check 
to become a registered user of Audition for Windows 95/NT.

Corporate Licensing
Audition for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and 
use Audition on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk 
and entitles you to unlimited free updates and telephone support. You can always download the latest release of Audition directly
from the Software Design web site on the Internet. Print the Audition for Windows 95/NT Order Form and mail it with your check 
to become a registered user of Audition for Windows 95/NT.



Audition for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

Secure on-line credit card orders can be placed from the Software Design web site.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of Audition for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



Credit Card Purchases
Credit Card Purchases
You may purchase Audition for Windows 95/NT by credit card over the telephone or directly from my web site on the Internet.

On-line Registration
Secure on-line registration using a major credit card is available directly from the Software Design web site. Simply go to the 
Audition for Windows 95/NT program description page and click your mouse on the RegNet link. You may register Audition for 
Windows 95/NT using your Master Card, Visa, American Express, Discover or EuroCard. Registration keys will be sent to you 
via eMail.

Telephone Registration
You may also purchase Audition for Windows 95/NT toll-free by telephone. Please specify Audition for Windows 95/NT when 
ordering.

Toll-Free: 1.800.999.2734
International: 1.805.288.1827
FAX Line: 1.805.288.1867

Web Site
Click your mouse on the underlined link below to purchase Audition for Windows 95/NT by credit card.

Software Design Web Site

(http://www.execpc.com/~sbd)



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of Audition for Windows 95/NT may either be used by a single person who uses the software personally 
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of Audition for Windows 95/NT through a network,
provided that you have obtained a site license for the software covering all workstations that will access the software through 
the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of Audition for Windows 95/NT through a 
network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of Audition for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Customizing Help
Customizing Help
You can customize this help file to better suit your needs and uses. The following topics describe the various settings that can be
configured. The settings you specify will be saved and used again each time you view this help file.

Font Size
The size of the font used in this help file can be made larger or smaller by selecting the Font item from the Options menu 
above. Select Small, Normal or Large fonts from the popup menu. The font size you select will be saved and used again each 
time you view this help file.

Window Size
The size of this Help window and its location on the desktop can be adjusted using the standard Windows resizing and 
placement methods. The window size and its location on the desktop will be saved and used again each time you view this help 
file.

Window Background Color
The background color for this help window can be changed to white if you prefer. To change the background color to white select
the Use System Colors item from the Options menu above. For the color changes to take effect you will have to close and 
then reopen the Help file. You will be prompted to confirm this action. Your background color selection will be saved and used 
again each time you view this help file.

Window Placement
By default this help window positions itself in front of all other open windows. If you would prefer to have it covered up by other 
active windows select the Keep Help on Top item from the Options menu and then select Not on Top from the popup menu. 
Your selection will be saved and used again each time you view this help file.

Note The settings described on this page refer to options available in the MS Windows Help program not Audition. Right-click 
your mouse anywhere on this page to display a small popup context menu containing the settings described here.






